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Introduction
© 2016. All rights are reserved. No part of this document may
be reproduced without permission.

While all efforts have been made to ensure the accuracy of all
contents in this manual, we assume no liability for errors or
omissions or statements of any kind in this manual, whether
such errors or omissions or statements resulting from
negligence, accidents, or any other cause. The contents of
this manual are subject to change without notice.

Protect our environment! We strive to produce products in
compliance with global environmental standards. Please
consult your local authorities for proper disposal.

Note: User's Manual is just to guide the user about the
functionality of the phone. This does not substantiate any
certificate of technology. Some functions may very due to
modifications and up-gradation of software or due to printing
mistake

Welcome

Congratulations on your purchase of our phone. Your phone
provides many functions which are practical for daily use,
such as a MP3 player, Loud Speaker, Games & more

You can read the manual for complete knowledge about the
use of the mobile handset and experience the frequently used
functions, simple & smart usage. Please use the original
accessories in order to achieve best results. Use of
non-original components may cause damage to machinery,
for which the company shall not be held responsible.

For Your Safety
Before using your handset, please read the following important
information to eliminate or reduce any possibility of causing

damage and personal injury.
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Do not switch your handset on when the use of
wireless devices is prohibited or when the wireless

device may cause interference or danger.

Do not use your phone while driving.

Follow relevant rules or regulations in hospitals and
health care facilities. Switch your phone off near

medical devices.

Switch your phone off in aircraft. The radio signal
from it may cause interference in signals of the

aircraft.

Switch your phone off near high-precision
electronic devices. It may affect the performance

of these devices.

Do not attempt to disassemble your phone or its
accessories. Only qualified personnel may service or

repair the phone.




Do not place your phone and its accessories in

ﬁ‘: containers with strong electromagnetic field.

Do not place magnetic storage media near your

| | phone. Radiation from the phone may erase the

information stored on them.

Do not put your phone in a high-temperature place or

E use it in a place with flammable gas such as a petrol

pumps.

Observe any laws or regulations on the use of

@ phone. Respect others' privacy and legal rights

when using your phone.

Improper use will invalidate the warranty! These safety instructions
also apply to original accessories.

Emergency call

If any emergency arises, dial 112/911 (or other emergency call
number) for emergency help.

Note:

Due to the nature of cellular networking, the success of emergency
call is not guaranteed.



Handset overview
Powering On/Off the Mobile Phone
1. Hold the End key for a while to power on the mobile
phone(So it is with the Powering off phone)
2. The phone will automatically search for available
networks.

Phone Lock Code

Phone code could prevent your phone from illegal use. The default
phone code is 1234. Please change it to your own as soon as
possible.

Notes: Please remember the code; otherwise some service expense
may happen.

PIN and PUK

PIN Code

PIN code could prevent your UIM card from illegal use. When PIN
is lock is on, you should enter the PIN code when powering on the
handset again. The network provider offers you PIN code (four to
eight digit).You should change PIN code as soon as possible for
security.

PUK Code

Consecutive inputting wrong PIN code for three times can cause
locking of UIM card. To Unlock, you need PUK code.

Notes: PIN code and PUK code may be offered together with the
UIM card. If not, please contact your network service provider.
Please change default PIN code to your own as soon as possible.
Memory Card

The Memory Card is pluggable storage cards inside the mobile
phone. To insert the Memory Card, open its latch, insert the card
into the card slot, and then close the latch. To remove the Memory
Card, open its latch and slightly take the card out. And then close
the latch.

Important password



Phone lock password is default 1234
Charging the Battery
1. Insert the lead from the charger to the socket, and
connect the charger to a standard wall AC socket.
2. After the completion charging, disconnect the charger
from the phone and AC socket.

Key functions:

Key Function Description

Call Key Make or answer a call.
Press the Call Key in standby mode to enter All Calls
list.

END key End an active or reject a call.
Hold to Power On/Off.

Exit from any interface to standby mode.

Left soft key Enter main menu in standby mode.
Select the correct option on a different interface

Right soft key Enter all the contact in standby mode.
In the menu interface execution returns

Navigation keys Move the cursor up ,down, left and right

In standby mode, used as hot keys to enter the
designated functions.

In contact list, press the Left key or right key to switch
groups.

Press the up key or down key to adjust volume in
conversation.

Used as direction key in games.

OK key Confirm the commands and option selected.
Confirm the character chosen while character inputting.

0~9 Number keys | Input numbers or characters.
Press the * Key twice to input + in standby mode.
Make a speed dial call (1~9) in standby mode.

Press to enter corresponding submenu.
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# key Hold the #key in standby mode to enable /disable Silent
mode.

Press the # key to change the text mode when edit text.

*key Press the * key to enter symbols in text input mode.

Menu directory

Phonebook

The mobile phone can store up to Contacts. The contacts store in
the mobile phone and in the UIM card. After selecting a telephone
number in the contacts, select option to perform the various
operations like Text messages, New, Delete, Import/Export, Batch
to mark & more. Search function enables you to find contacts
quickly. You can assign contacts to the default caller groups. View
the speed dial list and set the speed dial.

Message

Write message: From the main menu select “Write message” to
create message. You can save your messages that you send
often to “Save as draft” . While writing a message, select

“Option” to access all the messaging options like
Send/Add contact info/Insert template/Save as draft/Exit

Inbox: Received messages are listed in this item.
Outbox: Sent failed messages are listed in this menu.
Sentbox: Sent messages are listed in this menu.
Drafts: Draft messages are listed in this menu.

Templates: Some common used messages preformatted in the
phone. You can view, edit, delete or send them,
besides you can create new templates.

Messages settings: Change the general/SMS/MMS settings;

Check the information storage capacity

Call history




Call history: View call log. Select Option to perform more

operations accordingly.

Call timers: Check the call duration and clear the corresponding

time

Game

Game

1. Sokoban
2. Snake
For details, please refer to the operation instructions of the game.

Multimedia

Audio player

Play an audio file

1. Path of operation: Main menu> Multimedia> Audio.

2. Player interface on the key or the option to enter the playlist
update list (need to plug the T-card, MP3 files in the My Music
file)

3. Select the music track list, press the [OK key] music files start
playing.

Camera

1. Operation path: Main menu> Multimedia>Camera.

2. Phone display as a viewfinder for the objects you need to shoot,

click on the button, the phone will generate photo displayed on the

screen.

3. Photo preview state, you can choose whether to delete the
photos.

4. If you want to browse the photos of the operation to save, click
the left soft key - Photo album.

5. If you need to set the photo effects used in the camera viewfinder
state path: left soft key> Effects> Normal / B & W / Blue / Green /
Yellow / Sepia /Negative.

Recorder

Recorder (T card is required)

1. Path of operation: Main menu> Multimedia> Recorder.



2. If you need to turn on the recorder, the recorder interface press
the [OK key] to open the recording function.

3. The state of being recorded, press the [Left key] to pause
recording; press the right soft key to stop recording.

4. After the recording is finished, return to recording standby
interface.

5. Select the recording folder View saved audio file

Profiles

In order to use this phone in different scenarios, set personalized
ring tones and phone tone.

1. Need to set the scene mode, press the [Left key] to open the
parameter setting interface.

2. You need to set the type and settings, the setup is complete, save
the set value.

3. When the the phone return profile list, select the profile, open the
profile.

Settings

Display Settings: you can change the settings of wallpaper,
contrast, backlight time, and automatic keylock.
Phone Settings: Language: set the phone language.

Date and Time: set the phone to the reference
time: time display format date display format.

Shortcut:  Set up, down, left and right shortcut

icon.

Restore factory: To restore the factory settings.
Call Settings:
Call waiting: If the call waiting function is ON, the network will alert
you and the mobile phone screen will display the incoming call number if
others are calling you while you are already in a conversation. If the call
waiting function is OFF, the network will not alert you when others are
calling you while you are already in a conversation.
Call divert: This network function enables you to forward incoming calls to
another number in different condition i.e. forward always, Busy, No Reply
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and Default which you have specified.
Security Settings:
User can change the settings of Automatic Key lock, Phone lock, PIN
Lock.
The preset password is 1234.
Connection settings:
The items are :

Network account: Manage internet account, and support editor
and delete.

Data connection settings: Select to connect as needed or all the
time.

Network selection: Select to automatically or manually connect.
My stuff
Use the file manager treatment stored files in the phone or external
memory card, such as pictures, photos, music, ring tones. You can
create, move, copy, file, folder.
If all the storage space is fully occupied, the phone will not be able
to continue to store any files until some files are deleted.
View files
Tools

Calendar

You can in calendar storage time arrangements, anniversaries,

appointments, memos

Calendar

1. Path of operation: Main Menu> Tools> Calendar.

2. Choose the new date of the event in the calendar, press the [OK
key] to display details.

3. Option select "Add new schedule" in the calendar entry is set to
enter the event Subject, date, time, Ringtone, Repeat mode.

4. After completing the settings, press the left soft key to save the
information.

Alarm
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The alarm can also be set for a specific time at a specific date loop
start alarm. When the phone is set to silent or turned off, the alarm
function is still available.

Set the alarm

1. Path of operation: Main Menu> Tools> Alarm.

2. The phone supports multiple alarm settings, use the up and down
navigation keys you want to set the alarm, press the [key] to
enter the alarm edit page.

3. Use the up and down navigation keys to turn input alarm
parameters, select "Save" and confirm to turn on the alarm.

4. Click on the "left soft key" to open or close the selected alarm.

5. When the alarm clock to remind, click the "snooze" after three
minutes snooze alarm

Calculator

The phone supports a simple calculator functions, including

addition, subtraction, multiplication, and division operations.

Including the decimal point, the operands and results.

Using the Calculator

1. Path of operation: Main Menu> Tools> Calculator.

2. Simple arithmetic, the input sequence: first operand> operation
symbol (addition, subtraction, multiplication and division)>
second operand> equal sign.

3. For continuous operation after the results of the use of an equal
sign as the first operand, to continue entering operation symbols
and the second operand.

4. The calculator in accordance with the order of input operations.
The calculated results are displayed in the input area.

Browser

Internet is an application platform integrating wireless
communication and Internet technology, which makes it possible
for you to access to rich Internet information source and
e-commerce application etc.

Open the starting page of the brower, users can enter into input
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URL, search, bookmarks, history and stored pages through the
interfaces.

Problems and solutions

To save you time and unnecessary expense in contact before the

professional service, the following simple checks.

Unable to activate the phone

* 0 Check for and hold the power button for at least 1
second.

oo Check whether the battery is poor contact, please remove
and then reinstall retry boot.

o Check whether the battery is exhausted, please charge.

Activate the phone information

oo Enter the phone lock code, use the automatic locking
function, the password must be entered before using the phone.

o Enter your PIN, the choice to enter the PIN each time
you turn, you must enter the PIN code; (use the phone for the
first time, you must enter the PIN code that came with the UIM
card).

oo Enter PUK: connect three times to enter the wrong PIN
code will lock up the phone, you should enter the PUK code
provided by the network operator.

UIM card error

L3 UIM card metal surface dirt, UIM cards with a clean
cloth to wipe the metal contact points.

oo UIM card is not installed, the description of the UIM card
is properly installed in accordance with the user manual.

o o UIM card is damaged, contact your network service
provider.

Unable to connect to the network

oo Weak signal to a strong signal to retry.

o o Beyond the network coverage area of the network

service provider.
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oo UIM card is invalid, contact your network provider.
Number call can not be set aside

L Please confirm whether pressing the dial key after
dialing.

oo Please confirm whether arrears banned call.

o Please make sure the UIM is valid.

o Please confirm whether the call barring function.

Call quality is poor

oo Please check whether to adjust the volume inappropriate.

o Use of mobile phones in poor reception areas, such as
high-rise near or basement, radio waves can not be effectively
communicated.

* . The use of mobile phones in call-intensive period, as
indicated in the commuting time line congestion caused not
call.

Contacts can not call you

oo Make sure the phone is switched on and connected to the
network.

oo Please confirm whether due to arrears incoming banned.

oo Please confirm the UIM card is valid.

Contacts can not hear you

oo Make sure that the microphone is turned on.

o Keep the phone the lower part of the microphone close to
your mouth.

Standby time is short

oo Standby time and the network system is set, and may be

in a poor reception region. When no signal is received, the
phone will continue to launch in order to find the base station,
consume a lot of battery power, resulting in shorter standby
time. Please move to signal strong or temporarily turn off the
phone.

oo Need to replace the battery, replace the batteries with
new ones.

Can not be charged
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Poor contact, check if the plug is connected.

The filthy accumulation, with a soft clean cloth to wipe
the phone and battery wiring port.
Charge lower than 0 ° C or above 45 ‘C environment,
change the charging environment.
Battery or charger is damaged and need to be replaced.

If the above instructions do not help you resolve the problem,
please record the model and serial number of your phone,
authorization or insurance information, as well as issues clear
description, then contact the local service provider.

ROHS Directive Description
Various parts of the phone contains toxic and hazardous substances
or elements Description

C Hexaval | Polybromin Polybromin
Le Merc ated
Part ad d ury ent ated biphenyl
Names C chromiu | biphenyls
P d He m Cré + (PBBs) ethers
PBDEs
Motherbo
ard o oo o} o o)
Case o o|o o] o} o}
Assembly | o o|o o o o
Headset |0 |o | o o o) o)
Data lines | o o|o o o) o)
Charger |0 |0 |O e} o o)
Battery | o o|o o o} o}
Package | o o|o o o o)

Note: SJ/T11363-2006 standard limit requirement: Cadmium C d

=

= 100ppm; lead Pb, mercury Hg, hexavalent chromium Cr6 +,

polybrominated biphenyls (PBBs) and polybrominated diphenyl
ethers of PBDEs = 1000 ppm.
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l.o: table indicates that the content of this toxic or hazardous
substance in all homogeneous materials of the part below the limit
requirement in SJ/T11363-2006 standard.

2. Part of the components the lead exceeded belongs technically
have yet to find a substitute can not be replaced, in line with the EU
RoHS Directive exemption clause.

This product above components of environmental protection useful
life of 20 years. In the case of use in accordance with the conditions
of use of the product, from the date of production, the signs of life
of toxic and hazardous substances or elements contained in the
product does not cause serious pollution to the environment or to
persons, serious damage to property.

FCC Warning:

This device complies with part 15 of the FCC Rules.
Operation is subject to the condition that this
device does not cause harmful interference.

Any Changes or modifications not expressly approved by the party
responsible for compliance could void the user's authority to
operate the equipment.

This equipment has been tested and found to comply with the
limits for a Class B digital device, pursuant to part 15 of the FCC
Rules. These limits are designed to provide reasonable protection
against harmful interference in a residential installation. This
equipment generates uses and can radiate radio frequency energy
and, if not installed and used in accordance with the instructions,
may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in
a particular installation. If this equipment does cause harmful
interference to radio or television reception, which can be
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determined by turning the equipment off and on, the user is
encouraged to try to correct the interference by one or more of
the following measures:

-Reorient or relocate the receiving antenna.

-Increase the separation between the equipment and receiver.
-Connect the equipment into an outlet on a circuit different from
that to which the receiver is connected.

-Consult the dealer or an experienced radio/TV technician for
help.

The SAR limit of USA (FCC) is 1.6 W/kg averaged over one gram of
tissue.

Device types Profile 3G (FCC ID: 2ADLIPROFILE3G) has also been
tested against this SAR limit. The highest reported SAR values for
head, body-worn accessory are 0.53 W/kg and 1.29 W/kg
respectively. The Max simultaneous SAR is 1.33W/kg. This device
was tested for typical body-worn operations with the back of the
handset kept 10mm from the body. To maintain compliance with
FCC RF exposure requirements, use accessories that maintain a
10mm separation distance between the user's body and the back
of the handset. The use of belt clips, holsters and similar
accessories should not contain metallic components in its
assembly. The use of accessories that do not satisfy these
requirements may not comply with FCC RF exposure requirements,
and should be avoided.
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FCC Hearing-Aid Compatibility (HAC)

Regulations for Wireless Devices

On July 10, 2003, the U.S. Federal Communications Commission (FCC) Report and Order in WT Docket 01-
309 modified the exception of wireless phones under the Hearing Aid Compatibility Act of 1988 (HAC Act) to
require digital wireless phones be compatible with hearing-aids. The intent of the HAC Act is to ensure
reasonable access to telecommunications services for persons with hearing disabilities. While some wireless
phones are used near some hearing devices (hearing aids and cochlear implants), users may detect a buzzing,
humming, or whining noise. Some hearing devices are more immune than others to this interference noise,
and phones also vary in the amount of interference they generate. The wireless telephone industry has
developed a rating system for wireless phones, to assist hearing device users find phones that may be
compatible with their hearing devices. Not all phones have been rated. Phones that are rated have the rating
on their box or a label located on the box. The ratings are not guarantees. Results will vary depending on
the user's hearing device and hearing loss. If your hearing device happens to be vulnerable to interference,
you may not be able to use a rated phone successfully. Trying out the phone with your hearing device is the

best way to evaluate it for your personal needs.

The Hearing Aid Compatibility rating is displayed on the wireless phone box.
A phone is considered Hearing Aid Compatible for acoustic coupling (microphone mode) if it has

an “M3” or “M4” rating. A digital wireless phone is considered Hearing Aid Compatible for

inductive coupling (telecoil mode) if it has a “T3” or “T4” rating.
The tested M-Rating and T-Rating for this device (FCC ID: 2ADLJPROFILE3G ) are M4 and T3.

Hearing devices may also be rated. Your hearing device manufacturer or hearing health professional may
help you find this rating. Higher ratings mean that the hearing device is relatively immune to interference
noise. The hearing aid and wireless phone rating values are then added together. A sum of 5 is considered
acceptable for normal use. A sum of 6 is considered for best use.

In the above example, if a hearing aid meets the M2 level rating and the wireless phone meets the M3 level
rating, the sum of the two values equal M5. This should provide the hearing aid user with “normal usage”
while using their hearing aid with the particular wireless phone. “Normal usage” in this context is defined as
a signal quality that is acceptable for normal operation. The M mark is intended to be synonymous with the
U mark. The M and T marks are recommended by the Alliance for Telecommunications Industries Solutions
(ATIS). The U marks is referenced in Section 20.19 of the FCC Rules. The HAC rating and measurement
procedure are described in the American National Standards Institute (ANSI) C63.19 standard.

For information about hearing aids and digital wireless phones
FCC Hearing Aid Compatibility and Volume Control:
http://www.fcc.gov/cgb/dro/hearing.html

Gallaudet University, RERC:

https://fjallfoss.fcc.gov/oetcf/eas/reports/GenericSearch.cfm




